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Lab 1:  Introduction to the Equipment 
Goal for the module: 
Become familiar with the hardware and software of a modern research microscope. 

Introduction 
Much research in the life sciences requires measurement of the localization and dynamics of 
biomolecules in cells.  The characteristic size of most cells is too small for direct visualization, 
but is compatible with the resolution of the optical microscope.  Innovations in microscopy 
and the introduction of new techniques have produced an explosion in the use of the optical 
microscope in modern life science research.  By the end of this course you will be familiar 
with optical microscopy techniques and their application to cell biological systems. 
The properties of the optical microscope are governed by the radiation that it manipulates.  
Recall that light is electromagnetic radiation that has a characteristic wavelength and frequency 
for each different color.  The glass lenses in a microscope transmit visible light as well as light 
that is of somewhat shorter and longer wavelengths.  This wavelength range has been selected 
because the microscope, through its history, has been used dominantly by humans viewing 
microscope images directly with their own retinas.  In the past couple of decades, however, the 
wavelengths of light accessible to the optical microscopist have increased.  This is due to the 
introduction of electronic detection methods and the broader wavelength sensitivity of these 
devices.   
In this course we will use Nikon research-grade microscopes that can form brightfield, phase-
contrast and fluorescence images.  (These will be explained in much more detail in later lab 
modules.)  A research-grade digital charge coupled device (CCD) camera from QImaging 
Corporation is connected to the microscope through a side port and can be used to collect 
images suitable for quantitation. The particular camera on your microscope is a QICAM 12-
bit mono fast 1394 cooled model.   

Materials 
A glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells that have been 
stained with DAPI, a fluorescent marker for DNA. 

Procedures 
Task 1. Signing into the computer and the course Moodle site. 
Throughout the semester, you will be making, editing, analyzing, and storing, digital images, 
as well as uploading them to the course Moodle site.  In this task, you will learn your way 
around the computer and the course Moodle site. 
1. Log into the computer with your BCRC ID and password.  If you don’t have a BCRC 

account, 
a. Have someone else sign into the computer for you. 
b. Open Firefox. 
c. Click on “course accounts” on the BCRC homepage. 
d. Follow the directions to set a BCRC password after authenticating with your OIT NetID 

and password. 
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Task 2. . Turning on the microscope (without destroying it) 

1. Remove the microscope cover. 
Set aside on shelf or lab bench, 
not near the Epi-illuminator 
(black box to the right of 
scope), which gets very hot. 

 

 
 

2. Turn on the transmitted light 
illuminator power box (the dia-
illuminator) 

 

 

 

3. Turn on the lamp for transmitted light.  
The on/off switch is on the front left of 
microscope base. 

 

 
 

4. If you plan to use the fluorescence epi-illuminator, turn on 
the epi-illuminator power supply (large box; green light on 
the left lights up).  Push and hold in the start button until 
the  red/yellow light on the power supply turns on.*   
 
This start procedure involves a high-voltage spark in the 
lamp.  The sparking produces a voltage transient that can 
disrupt sensitive electronics.  Keep your hands away from 
the microscope when you start the epi-fluorescence lamp. 

 
 

                                                
*  The arc lamp in the epi-illuminator lamp housing gets very hot during operation.  The lamp must COOL 

between lamp lightings.  Therefore, you must wait at least 30 minutes after the lamp is turned off before 
turning the lamp back on.  Likewise, the lamp should be allowed to fully warm up before turning off, so leave 
it on at least 15 minutes after it is turned on. 
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5. If you plan to use the 
fluorescence shutter, 
turn on the shutter 
controller (black box, 
toggle switch on rear). 

 
 

 

6. If you plan to take digital 
images, turn on the camera.  It 
has a toggle switch on the end. 

 

 
 
When you are finished with the microscope, turn off BOTH lamp power supplies, the camera 
and shutter.  The order in which you do that does not matter. 
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Task 3. Observing cells 
One of the most important aspects of optical microscopy is to locate a specimen of interest, to 
place it in the field of view, and to get its image in focus.  Follow the steps below to observe 
fixed cells using phase contrast microscopy.  Refer to Figure 1 (taken from the Nikon 
instruction manual available on the course web site). 

 
Figure 1.  Photograph of the left side of the microscope base. (Image from Inverted 
Microscope Eclipse TE2000E Instructions, reprinted with permission from Nikon.) 

1. If you have not already turned on your 
microscope, do so now.  Follow the 
turn-on procedure on page 9. Locate the 
epi-illumination field block near the 
fluorescence excitation and emission 
selector wheel on the right side 
underneath the nosepiece.  Be sure that 
it is closed (“C”). 

 
 

2. Rotate the nosepiece (see Figure 1) so that the 10´ 
lens is facing up, toward the stage opening.  Use 
the side of the nosepiece for the rotation of the 
lenses so as to avoid fingerprints or other damage 
to the (expensive) microscope objective lenses. 
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3. Place your glass slide with cell cover slip side DOWN on the stage.  (The slide always 
should be put so that the cover slip, or the surface with the object to be examined, is closer 
to the objective lens.  This is an inverted microscope, so the glass slide is “inverted”, too.) 

4. Turn on the transmitted light condenser illuminator (Nikon calls this the Dia-illuminator), 
adjust it for brightness, and find some cells.  (See page 10.) 

5. This is often harder than it sounds.  You might try to observe through the eyepieces while 
you move the stage from side to side using the stage x-y positioning knobs (on the extended 
bar coming down from the stage).  The lateral movements allow you to find contrasting 
parts of the image, which you can then use to focus on the specimen.  Focus as you move 
the stage.  It is also helpful to partially close the condenser iris.  Histology slides, stained 
with bright dyes, are available for you to practice focusing on the sample. 

6. Can’t find cells?  Check the orientation of your slide, settings on the microscope and 
brightness of the illumination light.  Still can’t find cells?  Ask for help.  After you 
successfully find the cells, take note of the height of the lens relative to the slide/coverslip.  
This can help you focus on your sample in the future. 

7. Change to the Plan Fluor DLL 40× objective and find cells.  Can you find the same cells 
that you observed at 10×?  Again, take note of the height of the lens relative to the sample. 

Task 4. Fluorescence 
The use of fluorescent probes for cellular structures is a powerful tool that allows high-contrast 
images of cellular components to be visualized.  In this task, you will observe the same cells 
from the previous step, but now in fluorescence mode.  These cells have been treated with 
DAPI (4',6-diamidino-2-phenylindole, http://en.wikipedia.org/wiki/DAPI), a fluorescent 
probe that binds strongly to double-stranded DNA and, in doing so, shows the location of 
dsDNA in cells.   
1. Leave the 40× lens and cells in place.  Locate the rotating disk below the objective lens 

nosepiece, in the location “Black cover” shown in Figure 1.  The black cover has been 
removed and replaced with fluorescence filters and mirrors.   

The controls are on the right hand 
side as you face the microscope.  
Rotate the filter wheel until you find 
the “UV” click stop.  This sets the 
fluorescence filters in the microscope 
for the ultraviolet excitation and blue 
emission needed to visualize DAPI.  . 
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You have 4 filter cubes in your filter wheel, each set up for particular fluorophores: 
Label on 

filter 
wheel 

excitation 
 l emission l used for 

Label 
on filter 

UV UV 
 (360nm) 

Blue 
 (460 nm) DAPI UV 

2E-C 

B B  
(480 nm) 

Green  
(535 nm) 

GFP,  
fluorescein (FITC) 

B-
2E/C 

G G  
(560 nm) Red (630 nm) mCherry  

rhodamine 
Y-
2E/C 

LP B  
(470 nm) 

long pass green-red 
(> 500 nm) 

chlorophyll and GFP 
simultaneously B-2A 

2. Your microscope will have either a Sutter Instruments or a Vincent Associates shutter 
controller.  Determine which one you have. 
a) Sutter controller: The epi-illuminator shutter is manually opened by switching the 

toggle switch on the controller box to “Open” and is manually closed by switching the 
toggle to “Close”.  With the toggle in the middle “Auto” position, the computer controls 
the shutter.  The shutter should be set for manual operation and be closed. 

b) Vincent controller: The epi-illuminator shutter is manually opened by switching the 
right toggle to “Local”.  Then switching the left N.O./N.C. (normally open/normally 
closed) toggle on the Vincent Associates controller box to “N.O.” opens the shutter and 
switching to “N.C.” closes it.  With the right toggle in the “Remote” position, the 
computer controls the shutter.  The key switch should be in the “Std” position.  

3. Open the epi-illumination field block.  This is the rotating slider just below the epi-
illumination fluorescence filter selector wheel under the nosepiece.  The closed position is 
forward, marked as “C”.  The open position is back, marked as “O”.  This will allow 
fluorescence excitation light to pass freely into the microscope and therefore be gated by 
the computer-controlled shutter.  Open the shutter as directed above.   

4. Observe your cells. Turn off the transmitted light if it is on.  The DNA in the cells should 
fluoresce bright blue against a dark background.  Close the shutter when you are finished 
with the observations.  Leaving the epi-illumination turned on will photobleach your 
specimen. It will also bleach optical filters. Always be sure to close the shutter whenever 
you are not imaging by eye or camera.  
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5. Locate the epi-illuminator neutral 
density (ND) filters at the back of 
the microscope, on the right hand 
side, just before the light path 
from the arc lamp housing to the 
far right makes a turn into the 
microscope.  Turn the shutter on 
again and insert the ND 4, the ND 
8 or both filters into the light path. 
The ND 4 filter reduces 
illumination intensity by a factor 
of ¼.  The ND 8 reduces intensity 
by a factor of 1/8.  Together they 
reduce the intensity by a factor of 
1/32.  If in an experiment the 
fluorescence is too bright, you 
should use the neutral density 
filters in the excitation beam.    

6. You can also try simultaneous phase and fluorescence imaging (i.e., having both the 
transmitted light illuminator and the fluorescence illuminator turned on at the same time).  
Keep the transmitted illumination low, so that the fluorescence can be observed. 

Task 5. Digital imaging 
It is fine to observe directly with your eyes.  However, it is difficult to quantitate the image 
you see.  For example, can you tell what the average dimension of nuclear DNA is?  Is there 
more DNA in one nucleus versus another?  By taking and preserving digital images, you can 
use image analysis software to answer these questions.  In this task you will capture images of 
the cells in phase contrast and fluorescence modes. 

1. Use the 40 X lens.  Turn on your computer if it is not already on.   
2. Turn on the camera and the shutter if you haven’t done that already.  Locate cells with your 

eyes.  To look at the cells with the camera, do the following:  
a. Find Micro-Manager program in the Applications folder (it uses a microscope icon).  
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b. Open ImageJ. 
c. From the Plug-ins menu, find Micromanager, and then select Micromanager Studio

 

d. Select the correct configuration 
file (Vincent or Sutter config 
file, depending on your shutter) 
in the Micro Manager window 
to tell the software about your 
hardware.  Note that the camera 
must be turned on for the 
software to properly initialize. 
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e. Gently rotate the optical path switch dial 
on the bottom right front of the 
microscope.  This places a mirror in the 
optical path that moves the image from the 
eyepieces (“EYE) to the camera (“SIDE”).  
The image in the eyepieces will disappear.  
Please exercise caution when using this 
dial: be gentle because you are positioning 
a glass mirror that can break and also be 
sure that the knob “clicks” into position.   

 
f. To see an image on the computer, click the “Live” button.  If the image is too dark or 

too bright, adjust the light intensity in the microscope.  You are after a sharp image 
with good contrast.    

3. Experiment with your specimen and the camera.  Notice what part of the field of view is 
seen by the camera (this is due to a magnifying lens that sits in front of the camera.)  Notice 
any focal shift that occurs when you go between the eyepiece and the camera.  (When the 
camera is at the same exact focus as the eyepiece, it is said to be parfocal.  Your camera is 
probably not quite parfocal with the eyepieces.)  Get a feel for the response time of the 
camera, the way that the image changes with respect to changes in image brightness, and 
the camera’s resolution compared to your eyes’ resolution.  (Eyes are nearly always better 
for resolution when light is bright enough.) 

4. Take paired phase and fluorescence images of an interesting group of cells.  Try to get at 
least a few cells in the field of view.  To do this, 

a. Turn off the live image collection. 
b. Close the shutter and set it for computer control (Automatic).  Turn off the transmitted 

light by turning the lamp off with the button on the left bottom of the microscope. 
c. Take a single fluorescence image by clicking the “Snap” button.  If the exposure is too 

dim or bright, adjust it by changing the “Exposure [ms]” value.  Save the image to disk 
by using the “Save” button at the bottom of the image window. Save your images as 
Tiffs (Tagged Image File Format).  Tiff images are not compressed and can be used for 
analysis.  Other file formats use compression (jpeg, gif) and are therefore not suitable 
for quantification due to data loss. 

d. Make a folder with a your name and date.  Name your images with the date and other 
identification (cell 001; experiment 001 etc). While you are working, it may be easiest 
to keep this folder on the desktop.  Later you can move the file to a folder on Wahoo 
in the folder for your microscope..   

e. Take a single phase image by blocking off the fluorescence illumination light or turning 
the shutter controller to manual control and closed, which defeats the computer control 
of the shutter.  Don’t forget to turn on the transmitted light.  Save this image, too.  You 
may need to adjust the exposure time and/or image illumination brightness. 
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Task 6. Controlling the image display 
The Micro-Manager software that runs the camera is actually a software plugin for the freeware 
image-processing program called ImageJ.  You will use these programs throughout the 
semester. 
In this task you will use some of the features of ImageJ to get used to the program and to 
explore the properties of the camera attached to the microscope. 
1. Get cells in the field of view using fluorescence illumination for DAPI.  Snap a picture and 

save it.. 
2. The Micro-Manager display shows several pieces of information.  Next to the row of 

buttons at the top left is a list of “Camera settings”.  If you haven’t played with them 
already, do so.  Change the “Exposure [ms]” and “Binning” values and snap pictures to see 
what happens. 

3. Snap another image with binning set at 1.  The display at the bottom of the Micro-Manager 
window is a histogram of the brightness values (or “gray levels”) contained in the image 
that you just took.   
a. The histogram shows the number of pixels in the image (the vertical part of the plot) 

versus the brightness in the pixel (on the horizontal part of the plot).  More light falling 
on a pixel in the camera will give a larger signal that is translated into a brighter pixel 
on the displayed image.   

b. The plot shows the values contained in all the pixels of the image from full black (on 
the far left) to full white (on the far right).  Peaks in the graph correspond to gray level 
values that are the most commonly found in the image.  From your graph you should 
be able to see that there are a lot of dark pixels compared to the number of pixels that 
are bright (the DAPI-stained nuclei). 

4. That “Log hist.” box under the two display range control buttons changes the vertical axis 
on the plot to a logarithmic scale from a linear scale.  This allows you to expand the small 
values on the vertical scale relative to the large values.  Try it. 

5. With the image window and the Micro-Manager window both in view, click the “Full” and 
“Auto” buttons alternately.  Clicking the “Full” button makes the image appear black.  
Nothing has happened to the image data.  Rather, what you are doing is changing the 
displayed brightness of the image by changing the image gray level values that correspond 
to displayed brightness levels on the screen. 
The image that is displayed on the computer screen is a representation of a data file of 
numbers.  The usual way in which the numbers are converted to a screen image is to make 
the brightness of a particular image pixel proportional to the value in the data file for that 
pixel. 
The image produced by the camera has a limited gray level range, from zero to 4095.  The 
“Full” button causes the gray level value of zero in the digital image to be displayed as 
black and a gray level value of 65,535 to be displayed as white, with intervening values 
displayed in proportion to the numerical value in each pixel.   When you click the “Auto” 
button, the Micro-Manager software sets the minimum value in the image as black and the 
maximum as white.  (Notice that these values are shown under the “Log hist.” button on 
the left.) 
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6. Notice that the two slider controls underneath the plot change when you click the “Full” 
and “Auto” buttons.  You can manually adjust these two slider controls.  The top one sets 
the gray level value that is shown as black on the screen while the bottom one does the 
same thing for the gray value that is shown as white.   
Play with the controls to see how the image changes when you change these values.  All 
pixels that are equal to or less than the top slider value will be shown as black in the display 
and pixels equal to or greater than the bottom slider value will be shown as white.  By 
changing these values you can emphasize the parts of the image that you want to.   
Notice that the Min and Max values change as you change the sliders.  Those Min and Max 
values give the exact values below which pixels are colored black and above which they 
are colored white. 

7. The pull-down menu just below the “Min” and “Max” values changes the scaling on the 
plot at the right.  The default value is “camera” which means that the maximum value on 
the plot is set to the maximum possible value of the image data file that the camera and its 
software will produce.   
Your camera can make so-called 12-bit images, which means that each pixel in the camera 
can discern up to 4096 (that’s 2 to the 12th power) gray level values.  The computer doesn’t 
handle 12-bit files well, so the data is stored in a so-called 16-bit file (numbers can range 
up to 65,535).   
Because your camera images are created as 16-bit data files, the minimum for the “Full” 
button is zero and the maximum is 65,535.  Use the pull-down menu to change the scale to 
some value.  “16bit” will be the same as “camera”, while other settings will be different.  
Play with them to see how they affect the plot and the displayed image.  You should find 
that the image always behaves the same when you flip between “Full” and “Auto” while 
the plot looks a lot different.  The reason is that the pull-down menu changes only the scale 
on the gray level plot, but doesn’t affect the range of the lower sliders, which are tied to 
the data file.  You should find that the plot gives the full range of the camera when the pull-
down menu is set to “12bit”. 
It is possible to save a lower resolution image by using the “Pixel type” pull-down menu 
under “Camera settings” at the top middle of the window.  As you have already seen, the 
default is to store the full 12-bit range of camera data in a 16-bit file.  Change the 
“Pixel type” to “8bit”.  This means that the next picture that the camera takes will have a 
gray scale resolution of zero to 255 (2 to the 8th power is 256).  There are fewer possible 
gray levels, so the image contains less information than an image taken with 12 bit gray 
scale resolution.  The computer can handle 8-bit data files, so the image will be stored as 
an 8-bit file.  The image file will take up less storage space because only 8 bits need to be 
stored for each pixel.  This can be an issue in some applications, but we are using computers 
that have plenty of disk space, so we won’t be using this feature in subsequent modules.   
Take an image with the “Pixel type” set at “8bit”.  Then play with the histogram controls 
at the lower left of the window to compare how this lower resolution image is handled by 
the software. 
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8. There’s one more important control to play with in the Micro-Manager window.  The 

“Auto-stretch” box below the pull-down menu at the lower left of the window allows you 
to control the display of images as they are taken by the camera.  The function is best seen 
by example: 
a. Get an image on the camera and look at it “Live” with the camera.  If the “Auto-stretch” 

box is checked, the Micro-Manager software automatically sets the Min and Max 
values for each image that is collected so that Min is the lowest gray level in the image 
and Max is the highest.  This will effectively “stretch” the image gray scale so that the 
display is from full black to full white.  Notice that on the live image, when “Auto-
stretch” is ticked on that Min and Max change constantly.  This is because each image 
is slightly different than the previous image. 

b. Tick the “Auto-stretch” box off.  Now adjust the slider bars.  Notice that the live image 
display responds to your control.  Notice also that the Min and Max remain fixed where 
you set them. 

This control can be quite useful when you want to set the image so that the brightest area 
in the image is just below the maximum gray level that the camera can register.  It also can 
be useful when you want to follow changes in image brightness qualitatively as an 
experiment progresses.  You will do this later on in the semester to follow fluorescence 
bleaching as a function of time. 

Task 7. Saving image files to Wahoo 
Image files tend to be very large.  The ISB server, Wahoo, has space set aside for storage of 
Bioimaging files.  Keep your files here.  You can access these files from anywhere that has an 
internet connection.  You can also copy the files to another storage space for access (Google 
drive, Box, Drop box, thumb drive). 
There should be a link on the desktop that takes you to the Wahoo Bioimaging space.  Find the 
folder already set up there for your microscope.  Make a new folder with an informative and 
unique identifying name e.g., “Date, Lab 1 – Tom & Jerry” Save your image files there, 
creating identifying subfolders as needed, and keeping a record of what goes where. 

Task 8. Retrieving files from Wahoo 
From room 360 
Obviously, you can readily locate these files from any computer in room 360.   

On a networked Macintosh on campus 
Open a finder window, and pull down the Go menu.  Choose “connect to server” and type 
“smb://wahoo.cns.umass.edu/bioimaging”.  Sign in with your BCRC username and password. 

From anywhere else  
Download and install FileZilla following the instructions on the OIT web-hosting support page 
(http://www.oit.umass.edu/support/web-hosting). 

• Open FileZilla. 
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• Open Site Manager from the File menu, and enter the following: 
Select Entry: New Site 
Hostname: wahoo.cns.umass.edu 
Port: 22 
Protocol: SFTP – SSH File Transfer Protocol 
Logon Type: Ask for password 
User:  your BCRC username 

• Click Connect. 

• Enter your BCRC password, and click OK 

• Note: The first time you log in, a one-time screen warning you about an unknown host key 
may appear.  Check the box next to Always trust this host, add this key to the cache and 
click OK. 

• The remote site is something like this: /u1/home/bio/username (personalized with your 
username, of course). 

• Clear the Remote site box, and type this: /data/bioimaging  

• Enlarge the absurdly small window under the remote site bar and scroll to find your 
microscope folder.  Move files between local and remote folders by drag-and-drop, or by 
right click and upload (local to remote) or download (remote to local).  Voilá! 

Task 9. Sharing Images 
At various times you may be asked to post images to Moodle or put images in a certain folder 
on Wahoo to share with the class.   
1.  Convert one of your ImageJ images (stored as TIFF image files) to JPEG.  To do this, have 

an image displayed as you want it.  Go to the ImageJ>File>Save as>Jpeg… pull-down 
menu, make the filename sensible to you and put the file where you can find it. 

Task 10. Printing an image or file 
First, spend some time making the file look the way you want.  It’s hard enough to print without 
wasting time and effort printing something that looks ridiculous. 
Warning:  there are many steps to this process.  Much frustration, heartbreak, and wasted paper 
can be avoided by mastering these steps now. 

• Sign in with the print authorization widget on the desktop, using your BCRC username 
and password.  This should open up the print queue page. 

• Return to your file and select “print” from the file menu.  This does not send your job 
to the printer! 

• Notice the name of the printer, as this will tell you where to look for your printout.  
(The printers in ISB biology space are named after Pacific islands.)   

Printer name room 
Nifiloli 264 
Nupani 360 
Nukapu 364 
Ngawa 368 



22  Lab 1:  Introduction to the Equipment 

 

• You may be able to get a menu that lets you change image quality by looking at your 
options under “copies and pages”.   

• Use the preview function to make sure you will be printing the right thing.  Check 
which pages will be included. 

• Click print. This does not send your job to the printer!   

• You should be directed to the print queue page.  (If not, you can find the ISB print 
release page here: https://wahoo.cns.umass.edu/printrelease/.)  Refresh repeatedly until 
your job shows up.  Check the box for your job and click “release”.  (If you have made 
a mistake, this is a good time to cancel a job.)  This does not send your job to the 
printer! 

• After you release your job, you get a confirm release page.  Click “really print”, and 
this will finally send your job to the printer! 

Task 11. Microscope hygiene 
You should treat your microscope like the delicate instrument that it is.  Your microscope and 
camera cost over $35,000.  The objective lenses cost between $780 and $2300 each.   
Lens surfaces are coated with antireflective materials that can be scratched.  Never use any 
abrasive materials to wipe them.  Only lens tissues are soft enough to be used.  Dust should 
be blown off of optical surfaces, not wiped off. 
Use care when moving filters into the optical path, when switching from viewing by eye to 
viewing by camera and when switching fluorescent filters. 
If a part of the microscope doesn’t seem to work properly, don’t try to force it to move.  Ask 
an instructor if you have a question.  Learn the parts of the microscope and how they function 
so that you’ll know if there is a problem with something. 
The microscope should be covered when you are finished for the day.  Never put the cover on 
when power is applied to any part of the microscope, or if the lamp housing is hot.  The lamps 
and electronics produce lots of heat that can cause damage if not properly ventilated.  Always 
double check that all power is turned off before you cover the microscope.  This is very 
important. 

Tell the next user when you turned off your epi-
illuminator. 

 
 

Clean-up 
Save good slides for future use (and note which slide you used).  Discard (in the glass trash) 
any slides that had bad specimens, got cracked, or are totally photobleached. 
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Lab 2:  Image Formation in the Microscope 
Goal for the module 
Learning the basics of image formation in the microscope. 

Pre-lab homework 
Watch the iBio seminar on Kohler illumination (https://www.ibiology.org/talks/set-up-
koehler-illumination/) 
For additional information, visit Nikon’s MicroscopyU 
(http://www.microscopyu.com/sitemap.html).  Look over the contents to get a feel for what’s 
there and read the sections on refractive index, the optical train, Köhler illumination and 
phase contrast. 

Introduction 
The principles that allow the visualization of cells and cell structures in the optical microscope 
are based on so-called geometric optics.  This is the field that describes the redirection of light 
by lenses.  The ability of a lens to divert light arises from one fundamental aspect of the 
electromagnetic radiation that we call light: the speed of the light wave decreases when the 
light enters a medium from a vacuum.  You probably remember the relationship between 
light’s wavelength (l), frequency (u) and speed (c): 

 

This equation is valid when the light passes through a vacuum.  When it passes through a 
specimen, the speed of the light drops and the wavelength decreases, both by the same amount.  
The degree to which the speed drops and the wavelength decreases is called the index of 
refraction (n).  Therefore, when the light is in a medium, its wavelength is 

 

and its speed is 

 . 

This relationship is important because it shows why curved lenses with high refractive index 
bend light coming from air with a low refractive index.  In essence, the light takes longer to 
travel through a thick piece of lens as compared to a thin piece, and so the wave is retarded in 
the thick section of lens.  See Figure 2 and the tutorial at MicroscopyU 
(http://www.microscopyu.com/articles/formulas/formulasri.html). 
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Figure 2.  Light rays entering a medium of higher index of refraction at an angle have their wave 
fronts bent toward the normal of the medium due to the slowing of the rays by the high index 
medium.  If the medium is wedge-shaped, the waves are bent. 

The alteration of wave speed and wavelength in media of differing indices of refraction also 
affects the movement of light through a microscope specimen.  Although the differences in 
index of refraction between the surrounding aqueous medium and a cell are small, they can be 
exploited to produce image contrast. 

Materials 
Glass slide with a cover slip of fixed LLC-Pk1 pig kidney epithelial cells, stained with DAPI. 

A ruled stage micrometer. 

Procedures 
Task 1. Aligning the optical system for Köhler illumination 
Although a poorly aligned microscope can produce an image of a specimen, the best possible 
image can only be obtained when the microscope is properly aligned.  In this task, you will 
align the transmitted light portion of the microscope optical path.  The proper alignment of the 
light source and imaging lenses is said to follow Köhler illumination. 
1. If you have not already turned on your microscope, do so now.  You will not be using 

fluorescence in this lab, so do not turn on the epi-illuminator.  The arc lamp used in the 
epi-illuminator has a limited lifetime, and so should be left turned off unless you need to 
use it. 

2. Rotate the nosepiece so that the 10× lens is facing the stage opening.  Use the side of the 
nosepiece so as to avoid fingerprints or other damage to the (expensive) microscope 
objective lenses.  Rotate the eyepiece turret to the “O” position (see Figure 3.) Rotate the 
condenser turret to the “A” position (the one facing forward).  Both of these settings leave 
the optical path fully open. 
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Figure 3.  Adjustment points on the Nikon TE2000.  (Image from Inverted Microscope Eclipse 

TE2000E Instructions, reprinted with permission from Nikon.) 

  
 
3. Focus the sample.  For all subsequent steps, the sample must remain in focus.  Place the 

stage micrometer on the stage, turn on the transmitted light condenser illuminator, adjust 
it for brightness, and focus the stage micrometer.  Notice which side the stage micrometer 
is on.  That side faces the objective lens.  If you are having difficulty finding the 
micrometer, try to center it over the objective first by looking at the micrometer from 
above. 

4. Adjust the microscope for proper Köhler illumination.  (See Figure 3 for a key to the 
adjustable elements on the microscope.) 

a. With the stage micrometer still in focus, reduce the 
size of the field diaphragm by moving the lever.  
When the lever is in the up position (as shown in 
Figure 3), the diaphragm is fully open.  Moving it 
down will reduce its size.  You should be able to see 
an outline of the field diaphragm as you reduce its 
size.   
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b. Move the large black condenser focus knobs until the field diaphragm is in focus.  Do 

not change the focus of the specimen (the stage micrometer).  

  
You will note that the edges of the field diaphragm appear to have a color gradient, 
making the edge a bit difficult to discern.  This is due to what is called chromatic 
aberration in the lenses.  Chromatic aberration causes light of different wavelengths 
(colors) to focus at slightly different focal planes.   
You can limit this problem by restricting the range of wavelengths of light that are 
being observed.  One of the sliders on the right-hand side of the microscope top between 
the field diaphragm and the light source is a so-called bandpass filter that passes a 
limited range of wavelengths in the green range of the spectrum.  It is marked “G”.  
Push it into the beam path and see how the field diaphragm image is improved. 

c. Adjust the centering of the field diaphragm 
until it is nearly centered, using the two 
silver knobs on either side of the front of the 
condenser turret.  

 
d. It can be somewhat difficult to determine the center of the field of view when the field 

diaphragm is fully stopped down.  A trick to get perfect centering is this: Open the field 
diaphragm until it is nearly, but not quite out of the field of view.  The edges of the 
field diaphragm will be close to the edges of the field of view.  Tweak the centering 
until the field diaphragm is exactly concentric with the edge of the field of view.  Repeat 
b and c until you have a sharp field diaphragm that is centered. 

e. Open the field diaphragm a bit until the whole field of view is illuminated.  Open it just 
to the point that it disappears.  Opening farther than that will cause light to scatter inside 
the body of the microscope, thus degrading the image. 

f. The microscope is now set up for Köhler illumination.  What you have accomplished 
by this process is to direct light rays originating from the light source onto the focal 
point of the condenser (so that the light coming from the condenser is composed of 
parallel rays) and you have centered the condenser (so that the parallel illumination 
rays are also parallel to the optical axis of the microscope).  These adjustments must be 
made any time that you change objective lenses.  You should do this every time you use 
the microscope. 
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Task 2. Bright field imaging 
In this task you will use unstained cells to explore the ability of the microscope to generate 
contrast using transmitted light. 
1. Leave the microscope set up as in Task 1.  Place a slide with a coverslip of fixed 

mammalian tissue culture cells on the microscope.  Adjust the stage and focus to get cells 
in view.  This will be difficult.  The reason is that most animal cells have little in the way 
of pigments or coloring to produce image contrast that is necessary to provide the brain a 
way to interpret the image. 

2. Contrast can be gained at the expense of 
resolution (a topic to be covered in a later 
lab).  To do this, reduce the size of the 
condenser aperture diaphragm.  This is not 
the field diaphragm that you just centered. 
The condenser aperture diaphragm control is 
on the front of the condenser module, just 
below the two knurled nuts that you used to 
center the field diaphragm.   

 

 

You may need to increase the illumination level because reducing the condenser aperture 
will decrease the amount of light entering the specimen.  What is happening physically is 
that the diameter of the column of parallel rays is changing as the condenser diaphragm is 
changing.  This causes the cone of light emanating from the specimen to decrease, and this, 
in turn, reduces the resolution in the image, increases the depth of focus, and increases the 
contrast partly because the amount of background light in the image decreases. Observe 
your cells as you open and close the iris. How does the image change? 

3. Open the condenser aperture diaphragm as far as possible and still see cells.  You want to 
operate this way so as to keep the image resolution as high as possible, unless you need to 
increase contrast. 

4. Brightfield imaging is used for viewing stained samples, for example, histological 
specimens which are often stained with hematoxylin and eosin.  View an “H & E” stained 
slide, and notice the increase in visible structures. 

Task 3. Phase contrast 
As you saw in Task 2, strong contrast is not typically an inherent property of the specimen that 
is being observed.  Good contrast is produced by exploiting the interaction of the illuminating 
light with the specimen, and using the changes produced by the specimen in clever ways.  One 
such way is called phase contrast.  This method was invented by Fritz Zernike, for which he 
received a Nobel Prize. 
Phase contrast takes advantage of the fact that all microscopic samples diffract light and images 
are built up from the recombination of the un-diffracted (so-called zero order) and diffracted 
beams.  Think of the zero-order beam as the background.  Even absorbing (i.e., black) samples 
diffract light.  You can see this by blocking the zero order beam and noting a dark object 
becomes bright (we can demonstrate this in lab).  Absorbing samples look dark in part because 
the diffracted light is 180˚ out of phase with the zero order light and hence destructive 
interference ensues.  Transparent samples diffract light too, but introduce a phase shift that 
does not cause appreciable interference.  Phase contrast is a method to introduce a relative 
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phase shift between the diffracted and zero-order beams that lets them interfere destructively 
and gives rise to an intensity difference we can see.    
This is accomplished in the phase-contrast microscope by two circular, optical elements 
(Figure 4).  In the front focal plane of the condenser, there is an annulus that restricts the 
illumination to a ring.  In the rear focal plane of the objective, there is a phase ring (labeled 
phase plate in Figure 4) onto which the ring of illuminating light is focused.  The illuminating 
light is the zero-order beam, un-deviated by diffraction; when it traverses the phase ring, its 
phase is advanced or delayed (depending on the instrument design) relative to light passing 
through the rest of the rear focal plane.  It is also customary to reduce the intensity of the zero 
order beam by reducing the transmission of the ring. The annulus is built as an opaque sheet 
with an annular opening through which light passes; the phase ring is a flat plate, which is 
etched away or built up in a ring shape, at the appropriate diameter.  Phase contrast requires 
the illuminating annulus and the objective phase ring to be superimposed precisely.   

 

Figure 4. Main features of the phase contrast 
microscope. The Illumination is restricted to a 
ring by the annulus. The object (sample) 
diffracts light, giving rise to diffracted (dashed 
lines) and unaffected (“zero order”) light. These 
beams recombine in the image (not shown). The 
phase of the zero order beam relative to the 
diffracted beam is altered by a quarter 
wavelength at the phase plate, which allows 
destructive interference to occur, making the 
object appear dark.   

 

In this task you will set up the microscope for phase contrast imaging. 
Leave the 10× objective lens and cells in place from Task 2.  Confirm that cells are in focus 
and that the microscope is set up for Köhler illumination. 

1. Observe the tube of the 10´ objective.  It has “Ph 
1” printed on its side, which indicates that the 
objective has in its back focal plane a phase ring 
that partially obscures a circular annulus of the 
back focal plane.  This phase ring is matched to a 
clear annulus that can be placed at the focal plane 
of the condenser.  Rotate the condenser turret 
selector until it says “Ph 1” (at the front).  
Observe the improved contrast in the image.  
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2. The phase ring in the objective lens is fixed in place.  The condenser annulus can be moved, 
and needs to be aligned relative to the phase ring in the objective lens.  To do this, move 
the eyepiece turret selector to “B”, which stands for Bertrand.  There is a small silver knob 
to the right and underneath of where it says B.  Make sure the image of the annulus is sharp 
by rotating that knob.  A Bertrand lens allows the eyepiece to image the condenser focal 
plane rather than the specimen focal plane.  Because the condenser focal plane is the 
location of the condenser phase annulus (and is conjugate with the location of the objective 
lens phase plate), the Bertrand lens allows you to see the location of these two elements. 

   

3. If the condenser annulus is not 
concentric with the phase ring, 

  
 

use the red-handled tools on the side 
of the microscope to adjust it. There 
are two, recessed hex-head 
adjustment screws on either side of 
the marking on the condenser turret 
for this adjustment 
 

 
4. Return the eyepiece turret to the “O” position and observe the cells again. 
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Task 4. Exercise in adjusting the microscope 
In this task you will take a misadjusted microscope and return it to proper alignment.  When 
you are ready to do this, ask one of the instructors to misadjust the microscope.  You then will 
readjust the microscope and document your steps by taking pictures during the process. 
1. For this exercise, use the 10× lens.  You should follow the procedures above to first set up 

the microscope for Köhler illumination and then for phase contrast.  You should take note 
of the following as you align the scope.  Document with images if you want and record 
your observations in your lab notebook. 
• What do the cells look like when first focused in the misaligned microscope?   
• What does the edge of the unfocused field diaphragm look like as you begin the 

adjustment for Köhler illumination?  Compare it with the focused field diaphragm that 
has been centered. 

• Take an image of the cells in brightfield when the system has been properly adjusted 
for Köhler illumination, and another image of the cells when the phase annulus and 
phase ring are in place, but misaligned. 

• Finally, take an image of the cells when the phase annulus and phase ring are properly 
aligned. 

Save your images in a folder on Wahoo. 

Task 5. Image spatial quantification 
To begin this task, take some nice images of cells using phase contrast.  Now you will calibrate 
your microscope so you can determine the sizes of cells and structures within them. To do this, 
you will use a calibrated stage micrometer, a slide that has a very fine ruler etched into it 
(Figure 5). 

 
Figure 5.  Stage micrometer from Ward’s Science (part # 949910) 

1. Return the 10× objective as the active lens.  Remove the cell slide and replace it with the 
calibrated stage micrometer slide.  Notice which side the stage micrometer is on.  That side 
faces the objective lens. 

2. Using phase contrast, locate the stage micrometer by eye, center it, and get it into focus.  If 
you are having trouble locating the micrometer, look at it from above the microscope stage.  
You should be able to make it out with your eyes.  Move it to near the center of the objective 
lens and then try to find it in the microscope again. 

3. Get the camera image of the stage micrometer, optimize it and be sure it is in good focus. 
4. Take a single image of the stage micrometer and save it. 
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5. Switch to the ImageJ window.  Click on the line symbol and draw a straight line from one 
stage micrometer hash mark to another.  It will be most accurate if you draw the line from 
hash marks as far apart as possible.  (Why?) 

6. From the “Analyze” pull down menu select “Set scale…”.  The window that pops up will 
show you the distance in pixels of your line.  You need to type in the actual distance 
between the two hash marks that you used.  If you can’t figure this out, ask for help.  Be 
sure to use the correct units of measurement in the “Set Scale” box.  (1 cm = 104 µm.)  
Leave the aspect ratio set at 1.  Your camera has square pixels, so the aspect ratio 
(height:width) is 1.  Make this global. 

7. Put a scale bar on one of the two cell images from Task 3.  Use “Analyze > Tools > Scale 
Bar”.  Save this in a separate file, appropriately named, using the “Save as” button.  Make 
another Word or Open Office file with this image and an appropriate caption.  When a 
scale bar appears in an image, give the dimensions of the scale bar in the caption instead 
of adding that number to the image.  The scale bar is usually positioned in one corner of 
the image where it will not obscure any important image detail. 

8. Determine the size that a camera pixel represents when the 10× lens is used.  You can do 
this by dividing the known distance between hash marks in part 6 by the distance in pixel 
units from part 6.  This value is the number of µm per pixel (or cm per pixel if you prefer).  
This tells you how much of the specimen area falls on each pixel in the camera.  This value 
will remain the same for any future use of this objective lens and camera in this microscope.  
The value will be different for different lenses (and for different cameras, if you happened 
to use a different one). 

Further studies 
You now have the basic tools to set up the microscope for Köhler illumination and phase 
contrast.  You might want to examine other samples, comparing phase contrast with 
brightfield.  Try a stage micrometer.  Which imaging technique works best for a sample that 
has strong absorption contrast (like the stage micrometer)?  Are the camera pixels really 
square? To what accuracy? 

Clean-up 
Save good slides for future use.  Discard (in the glass trash) any slides that had bad specimens, 
got cracked, or are totally photobleached.  Return the micrometer to its box. 
  


